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Disclaimer 

This document reflects only the author's view and the Agency and the Commission cannot be held liable for 

any use made of the information it contains. 

The participants of the COOL DH consortium do not assume any responsibility for any use of the presented 

project results and deliverables as whole or in part. 

The heat loss simulation tool developed in the COOL DH project is based on heat loss formulas developed 

by the Technical University of Denmark (DTU) from previous work. The authors, the Agency and the 

Commission, assume no responsibility or liability for the content and/or result obtained with this tool. The 

participants of the COOL DH consortium assume no liability for the use of the tool, the presented results or 

deliverables as whole or in part. The information and results are provided with no guarantees of accuracy 

and completeness and the user assumes the entire responsibility for further use of the results obtained 

with this tool. 

Scope of deliverable 

The purpose of this deliverable is to create a calculation tool to calculate the heat losses from distribution 

and service pipes in buildings. The tool was developed using the software Microsoft Excel and it allows the 

user to select the input data and customise the calculations. 

Context of deliverable 

The tool was developed in relation to the project COOL DH, which is the acronym for "Cool ways of using 

low-grade heat sources from cooling and surplus heat for heating of energy efficient buildings with new 

low-temperature district heating (LTDH) solutions". COOL DH is a research project funded by Horizon 2020, 

the biggest EU research and innovation programme.  

The project will develop new solutions for low-temperature district heating networks, and as part of it, two 

real scale demonstration sites are going to be implemented. The first one is in the city of Høje-Taastrup in 

Denmark and the second one is located in the city of Lund in Sweden. 

Perspective of deliverable 

The heat losses from the distribution in pipes are often overseen, even though they can reach up to 10-15% 

of the total energy requirements in new and renovated buildings. Higher impact is expected during summer 

when the heat losses do not contribute to the space heating demand. 

The implementation of a better pipe layout and the use of PUR insulated pipes, co-insulated pipes or twin 

pipes, known as DH pipes, can lead to a reduction of heat losses in buildings. The heat losses calculation 

tool can give an overview of the heat losses that can be expected in a distribution system implemented in a 

building.  
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Summary  

This note presents the calculation tool for calculating the heat loss from the distribution pipes in buildings. 

The tool was developed with Microsoft Excel. The note guides the user through the settings of Microsoft 

Excel to start the calculations and afterwards it gives an overview of the inputs that the user can select 

during the calculation. 

Furthermore, the note shows how the results can be saved in the simulation tool and the possible errors 

that can be found during the calculation process. 

  



   
 

 
4 

 

Contents 
1 Introduction ............................................................................................................................................... 5 

2 Excel settings – Solver add-in .................................................................................................................... 6 

3 Heat loss calculations ................................................................................................................................ 8 

3.1 Inputs section .................................................................................................................................... 8 

3.1.1 Pipe section ............................................................................................................................. 10 

3.1.2 Insulation section .................................................................................................................... 11 

3.1.3 Temperatures section .............................................................................................................. 11 

3.1.4 Length section ......................................................................................................................... 11 

3.1.5 Flow rate section ..................................................................................................................... 12 

3.1.6 TWIN section ........................................................................................................................... 12 

3.2 Operation buttons ........................................................................................................................... 12 

3.3 Output overview .............................................................................................................................. 12 

4 Results tables ........................................................................................................................................... 13 

5 Heat loss calculation tool accuracy ......................................................................................................... 13 

6 Errors ....................................................................................................................................................... 14 

6.1 Calculation errors ............................................................................................................................ 14 

6.2 Excel version error ........................................................................................................................... 15 

7 References ............................................................................................................................................... 16 

 

 

  



   
 

 
5 

 

1 Introduction 
The following note introduces the Excel tool for the calculation of heat loss from the distribution pipes of 

domestic hot water or space heating systems.  

1.1 Background 
The heat losses in a district heating network are not only limited to the underground distribution pipes, but 

part of the heat loss is found in and between the buildings or building sections. In new and renovated low-

energy buildings, the heat losses from pipes can be up to 15% of the total energy need. During summer, the 

heat losses are more relevant since they do not contribute in covering part of the heat demand. Pre-

investigations indicate that heat losses can be reduced by 50-65% with a better pipe layout and use of PUR 

insulated pre-fabricated district heating pipes inside buildings. As it is shown in Figure 1, a better pipe 

layout in multi-family buildings can reduce the number of pipes used. The installation shafts can be 

optimized and aggregated to supply more than an apartment type.  

 

Figure 1. Optimised pipe layout in multi-family buildings 

Based on these considerations, the Excel calculation tool developed in this deliverable aims to help the user 

to calculate the heat loss from a heating system and simulate different solutions. The user can implement 

the system's data and get an overview of the heat loss results, which can help with the optimisation of the 

installation and the choice of the materials. Furthermore, different pipe layouts can be tested to give an 

insight on the best solution. 
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2 Excel settings – Solver add-in 
The workbook uses the Excel add-in called "Solver", which is a tool used for solving what-if analysis. It gives 

an optimal (maximum or minimum) value for a formula in one cell called objective cell, which is subject to 

constraints or limits. Solver modified the values of a group of cells or simply variable cells (decision variable) 

to satisfy the limits in the constraint cells and optimise the result in the objective cell (1). 

If the Solver add-in is not activated in the user's Excel version, it is necessary to activate it before starting 

with the heat loss calculations. The following guidelines shows the steps to activate the Solver add-in (2): 

1. Click on the "File" tab and then click on "Options". 

2. In the "Add-ins" section, select "Solver Add-in" and click the "Go" button as shown in 

Figure 2. 

 

Figure 2. Select the Solver Add-in in the window 
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3. In the new window check the "Solver Add-in" and then click "OK" as shown in Figure 3. 

 

 

Figure 3. Select Solver Add-in in the Add-ins window 

4. The Solver Add-in is now active and can be found on the "Data" tab as shown in Figure 4. 

 

Figure 4. "Data" Tab where it is possible to find the Solver Add-in 

Once the Solver is activated, it is possible to start with the heat loss calculations. However, the user has not 

to directly activate the Solver on the "Data" tab. 
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3 Heat loss calculations  

3.1 Inputs section 
The inputs area allows the user to insert the characteristics of the system for the calculation of the heat 

loss. There are three sections, for the different pipes in the systems, such as horizontal pipes (distribution), 

vertical pipes (distribution) and the service pipes. Figure 5 shows the inputs area for the horizontal pipes. 

 

Figure 5. Overview of the inputs for the horizontal pipes 

Figure 6 shows the different pipes in two DHW systems examples. The system on the left considers a 

district heating unit at the user, while the one on the right considers a common substation. The aim of the 

heat losses calculation tool is to calculate the heat losses from the distribution pipes in the building; 
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therefore, the heat losses from the district heating unit or the substation are not considered in the 

calculations.  

 

Figure 6. Representation of the different pipes in case of a DH-unit system and a main substation system 

Every section is then divided in subsections, where it is possible to insert specific information of the pipe, in 

order to calculate the heat losses.  

The data of each specific pipe must be entered in the light-red highlighted cells as show in Figure 7. 

 

Figure 7. Light-red highlighted cells where the inputs can be inserted 

The pipe material (lambda value) can be chosen from a drop-down menu as shown in Figure 8. The same 

drop-down menu is applied for the insulation materials as well as the emissivity of the external layer of the 

insulation. 

 

Figure 8. Drop down menu to choose pipe material as well as insulation material 

If the user cannot find a specific value in the drop-down menu, it is possible to select "User defined value:", 

which gives the possibility to type in a specific value in the dark-red highlighted cell that appear on the 

right, as shown in Figure 9. 

 

Figure 9. Possibility to type in a user defined value 
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3.1.1 Pipe section 
In the pipe section, the user can insert the pipe's features: 

 Name of the pipe: it is possible to set a name or a reference to the pipe. 

 Usage time: it allows the user to define the percentage of time (in a year) that is expected to have 

flow through the specific pipe. The number is given in percentage, in the range 0-100%. 

 Pipe type: it is possible to choose between single or twin pipes. 

 Inner diameter: it defines the inner diameter of the media pipe. 

 Outer diameter: it defines the outer diameter of the media pipe. 

 Pipe material: it defines the lambda value of the media pipe. 

Regarding the pipe type, the difference between single and twin pipe models is shown in Figure 10, which 

shows the simulation model for a single pipe and in Figure 11 shows the simulation model of a twin pipe. 

When the "single" pipe is selected, the calculation tool calculates the heat losses from a couple of single 

pipes that are insulated individually. The results give the average heat loss for the supply and return pipes 

together. 

 

Figure 10. Simulation model of a single pipe 
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Regarding the twin pipe model, the supply and return pipes are embedded together in the same insulation. 

Also, in this case, the heat loss result gives the average heat loss from the twin pipe as combination of the 

supply and return pipe. 

 

Figure 11. Simulation model of a twin pipe 

3.1.2 Insulation section 
In the insulation section, the characteristics of the insulation layer can be inserted. 

 Insulation thickness: specify the thickness of the insulation layer. 

 Insulation material: it defines the lambda value of the insulation material. 

 Emissivity: it defines the emissivity of the external layer of the insulation material. The number 

must be in the range 0-1. 

3.1.3 Temperatures section 
In this section it is possible to insert the water temperature in the pipes as well as the characteristics of the 

environment that surrounds the pipe.  

 Ts - supply: water temperature in the supply pipe. 

 Tr - return: water temperature in the return pipe. 

 Ta - surroundings: temperature of the environment/air that surrounds the pipe. It is assumed that 

the air that surrounds the pipe is 1°C higher than the shaft where the pipe is placed. 

In the service pipes section, it is possible to define only the supply temperature, since the service pipes do 

not consider the return/circulation pipes. 

3.1.4 Length section 
In this section, the length of the pipe can be inserted. 

 Pipe length: it defines the length of the pipe/s that have the same characteristics. 
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3.1.5 Flow rate section 
In the flow rate section, it is possible to define the flow rate expected in the selected pipe. It is used to 

calculate the water velocity in the pipe. 

 Volumetric flow rate: it defines the volumetric flow rate through the pipe. 

3.1.6 TWIN section  
In the TWIN section, it is possible to define the distance between the media pipes in case of twin pipes. This 

number is not considered in the heat loss calculation for single pipes. Therefore, the cell can be empty 

during heat losses calculation from single pipes. 

 Distance between pipes: it defines the distance between the two media pipes in case of twin pipes. 

3.2 Operation buttons 
Once the features of the specific pipe are typed in, it is possible to proceed with the heat loss calculation. 

As shown in Figure 12, there are three operation buttons. The "Calc" button is used to calculate the heat 

loss from the pipe. It must be clicked every time there is a change of the data set. It is important to click it 

after every change in order to update the heat loss results. 

 

Figure 12. Operation buttons for the heat loss calculations in case of horizontal pipes 

When the outputs/results are optimised, by clicking the "Save" button it is possible to save the results and 

the pipe's feature in a table, as it will be presented in Chapter 4. 

If the results saved in the table are not optimised and it is necessary to change them, by clicking on the 

"Delete" button it is possible to delete the last line of the result's table. 

The three buttons are available for all the different typologies of pipes, such as horizontal pipes, vertical 

pipes and service pipes. 

3.3 Output overview 
Underneath the inputs area, it is possible to have an overview of the results of the heat loss calculations, as 

shown in Figure 13. The outputs change when the pipe's data are modified, therefore it is important to 

press the "Calc" button to update the results every time there is a change in the data set since the solver 

has to be run. If the "Calc" button is not clicked, the results are not optimised, and in the Outputs section 

the user can see the results from the last simulation. The button "Delete Outputs" allows the user to empty 

the results area. 

 

Figure 13. Output area with an overview of the heat loss results 
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The outputs give a first overview of the results and, once they are considered correct by the user, the 

results can be saved in the main tables as shown in the next chapter. 

4 Results tables 
As it is shown in Figure 14, the results from the heat loss calculation can be saved in a table. The table gives 

an overview of the pipe's features used in the calculation as well as the heat loss results. In particular, the 

results show the heat loss from one meter of pipe, the heat loss for supply and return and the energy loss 

from the supply and return in an entire year. 

 

Figure 14. Overview of the table where the results of the heat loss calculations are saved 

5 Calculation tool accuracy 
The calculation tool was tested and compared with the results obtained with similar tools available online 

(e.g. Rocktec from Rockwool A/S). Three different types of insulation were used during the comparison, 

each one characterised with a different U-value. The test was conducted with two different sets of 

temperatures for the supply/return pipes and with two different diameters of the media pipes.   

As results of the simulation test, the Excel tool calculated a heat loss on average between 10% and 20% 

higher than other tools. The difference can be due to the different calculation methods and the possible 

approximation of the different models, considering that the comparison tool is probably based on a 

theoretical calculation. Therefore, the results obtained with the Excel simulation tool guarantee to be on 

the safe side. 

Regarding the comparison with real life measurements, it is planned to compare the results from the Excel 

calculation tool with the results obtained from the measurements that will be conducted in the Explorion 

building, which is located in the COOL DH demo site in the city of Lund. 
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6 Errors 

6.1 Calculation errors 
In order to avoid possible errors in the calculation process, it was decided to advise the user in case of 

possible errors. For example, Figure 15 shows the error when one or more inputs are missing, and 

therefore the heat calculation cannot be performed. 

 

Figure 15. Error that shows one or more input missing 

Figure 16 shows the error when there is a mistake in the pipe's diameters, in particular when the inner 

diameter is bigger than the outer diameter. 

 

Figure 16. Error that shows a mistake in the in/out diameters dimension 

Figure 17 shows the error in the heat calculation. This means that the Solver add-in cannot calculate an 

optimized result. This could be due to an error in the typed inputs or a situation where the inputs are not 

reasonable, and it is not possible to find a result.  

 

Figure 17. Error in the heat loss calculation. the Solver add-in cannot calculate the optimal solution 
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6.2 Excel version error 
In case of undesired errors during the calculation (for example: Run-Time error '53': File Not Found: 

Solver32.dll) due to the different versions of the Excel software, it is possible to try the following solution:  

1.    Go to File > Options > Add-Ins > Manage Add-Ins Go Button (at the bottom) 

2.    Uncheck Solver add in. 

3.    Completely close all Excel spreadsheets and programs. 

4.    Open Excel. 

5.    Add the solver add-in back to Excel as it was shown in Chapter 0. 
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7 Applications of the calculation tool 
The Excel calculation tool can be used in the design phase of a domestic hot water system as well as a space 

heating system in a building, when the pipes are not embedded inside the construction materials, but they 

are surrounded by air.  

The tool can give an overview of the overall heat loss from the piping system as well as it can help with the 

design of the piping system itself, since it gives the possibility of testing different solutions. The user can 

type in all the segments that compose the system and choose different combinations of pipe materials and 

type of insulations. The tool has already a pre-defined list with the most common materials used in 

technical installation. Anyway, it gives also the possibility to choose personalized values.  

The results obtained from the calculations show the heat losses for each segment in watt per meter, the 

total loss in the segment and the energy calculate for a year, considering the percentage of time that it is 

expected to have water circulating in the pipe. Moreover, it gives the total loss in watt and the total energy 

loss in kWh per year. In this way, it is possible to calculate easily the economy of the heat loss.  

The tool can be directly used and tested during COOL DH project. In particular, it can be tested with the 

real-life installation results obtained from the measurements that will be conducted in the Explorion 

building, which is going to be part of the demo site in the city of Lund. Lastly, the Excel calculation tool can 

be used in the design process of the new town hall in the city of Høje-Taastrup, which is part of the second 

demo site of COOL DH project. Here a completely new building is going to be built.  
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